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Gen-01 Technology 
MATH 

What is "computer math" & why is it important? 
Computer math is comprised of very large numbers, very small numbers, and lots 

of fractions and percentages.  Computer speeds are measured of stated in "millions of 
"cycles per second",  "millions of operations per second or "Millions  of Instructions per 
Second" (MIPS) Storage devices and media are measured in "bytes" or characters of 
storage with large numbers representing large storage capacities. 

What is a byte? Byte = 8 binary bits  (0000 0001) 
1) is in the base2 numbering system 
2) = number between 0-255 Decimal (base10) 

Small Large 
| | | | | | | | 

nano micro milli kilo mega giga tera 
.000 000 001 .000 001 .001 0 1,000 1,000,000 1,000,000,000 ### 

Indentifier Amount Quantity Descri tion 
Teraby e trillion ### 
Gigaby e billion 1,000,000,000 
Megaby e million 1,000,000 
Kiloby e thousand 1,000 
By e 1 

Indentifier Amount Quantity Descri tion 
Megaher z million 1,000,000  ycles per second 

Indentifier Amount Quantity Descri tion 
Millisecond thousands .001 
Microsecond .000 001 
Nanosecond .000 000 001 
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Electrical c;harges are controlled by forcing ·t.11.em to . 
flow in circular paths. If the circulaT path is ·c w,e·d! the 
electricity is controlled. A circular path of elect rical charges is 
called. a circuit. 

All drcµ;its mt st have a sc:rnrce of eneTgy. This might be a 
battery,. The. elect-ti.cal energy flows th1·ough the insulated 
electrical wire .. It powers a machine such as a light bu.ib. Then 
it travels· l:>ac,k to tlw source of energy .along l:ll;l.Other ins.ulated. 
ele-ctrical w,i1·e. 

I 

I 

... ~ 
I 

The word circuit sounds I Ike 
SER-kiht. 

, __ -------------------------------------------

Safety with 
Electricity 

& 
Conductors 

Gen-03 

Tip#3 
People can be great 

electrical conductors 
and / or resistors. 

Tip #2 -
Resistors -Impede or resist the flow of 
electrons causing the resistive material to 

create heat and light. Tip #1 

Metals - Like copper  or 
aluminum wire (conduct) - they 
create a pathway for the flow of 

electrons (electricity) 

Conductors 
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General OverView 
DOS 

Operating Windows 3.11 
Windows 95/98 

Software Systems 
Windows NT 
Windows ME /2000 
Linux -RedHat, 

Applications 

External 

Hardware 
Internal 

Users 

Applications: 

1) Wordprocessing 
2) Games 
3) Spreadsheet 
4) Graphics 
5) Explorer 
6) Netscape 

Mandrake 

Printers CD-RW 
Keyboard Monitor 
Mouse Scanner 

Operating 
Systems 

1) Linux 
2) DOS 
3) MS Windows 
4) Unix 
5) Mac OS 

Word Processing,  Database 
Spreadsheet 
Games -Doom, Age of Emp. 
Photo Edit, Graphic edit 
Paint & Draw 
MS Office, StarOffice 

Hard drive 
Floppy Drive 
CPU 
Mother Bd 
CD-ROM/RW 
Memory 

Hardware 
CMOS & BIOS 

•1) IBM 
•2) Compaq 
•3) Dell 
•4) Clones 
•5) HP 
•6) E-Machines 
• 
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rj trl 

~ Cyt Ctrl+X 

IQ1 ~opy Clrl+C 

~ .E'_aste Ctrl+V 

Bename FZ 

1Jj Move to Trash Del 

~ Q.elete Shift+Del 

i;;;:;i _§_hred Ctrl+Shift+Del 

Copy files F7 

Move files FB 

Cl Create .New .. 
Edit File Type .. 

Propertie s .. 

_§_elect.. Ctr!++ 

jJnselect... Ctrl+-

Uns elect A ll Ctrl+U 

Ctrl+" 

II ~ LQcation file :/home/robertc 
- - - - --

~ ~ Bookmarks 

~ ~ ~ ~ ~ ~ 1B J:/History 
~ ~ Home Directory Blender De sktop Document download Graphics Mail Nautilus 
! ~ -- ~ Blender i i 
! 1B ()Desktop 

~ ~ ~ ~ ~ WJ ~ ! ! ~ Documents 
! IB·· ~ Graphics nsmail office52 robertc TechPrep !filnQ Tull.ii! 2002Scho core core.1552 
i : ~ Mail lorship.rtf Q 
! IB·· ~ Nautilus 
! ! ~ TechPrep ~ ~ ~ ~ ~ ~ ~ ~ ~ : IB-- ~ Typist 
! ! ~ autosave core.1956 core.2202 core.2227 core.2229 core.2743 core.2964 core.3137 core.505 Export 
i IB·· ~ blacklists l 1 ~ z. 1 Q 
! IB·· ~ downloads ~ ~ ~ ~ ~ ~ ~ ! ! ~ nsmail 
! 1B-- ~ office52 Export00. Export01. Export99. proce ss e session snapshot snapshot snapshot snapshot 
! 1B-- ~ robertc CSY csv CSY i 1Jlli!l ZJl.D_g .1,im_g UD.!l 
i IB ~ temp @ @ @ @ @ ~ ~ ~ ~ $~Network 
: $ - FTP Archives snapshot snapshot snapshot snapshot snapshot TE PAGE TE PAGE TE PAGE TE PAGE 
! 1B ~Local Network §Jllig fullig LJlM fullig ~ 1.doc 2.doc 3.doc 4.doc 

: 1B ~ Web Sites ~ 1B ~ Root Directory 

TE PAGE 
5.doc 

T
askbar 

Apps-01 

GUI Desktop &
File Management 

FIND 
Files Desktop 

ICONS 
File 

EXPLORER 

DESKTOP 
Windows 

START 
& Program 

Button 
DESKTOP 
Explorer 

KMAIL 
E-Mail OPEN 

Applications 
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file [dlt :itiew I ools ytlndow J:!.elr, 

r.J jti le:/ / /home/robertc/offlce52/user /desktop/ .':J 

lil ..J Strut 
@� Summercamp2001 
lil J Tech Prep 
l!l Temp 
IB :,J Work_S tudy 

robertC.kCS ii 

StarOfflce 

lJTech Tips ... 

/opt/office52/share/gallery 

C] bullets 
D clipart 
D clothing 
D communications 
Dcomputers 
D education 

' 

Actv 2.sda] 
Tools- M ocl if 

• .,.d,., 

--,-,es 8/17 /01, ... 

, 
Printer Setup 

;j 

SupportForum 
~ 
Tasks 

D electrical 
D electronics 
[] energy 
D entertainment 
(::] fantasy 
D flags 

!:) food & drink 
D furn iture 

10:S5 AM 

[] goYernment D med ical 
[] history of computer files D military 
D holidays D money 
[] kid's stuff Dm usic 

file:// /home/robertc/office52/user/work/C urr. ..... 

Finding things in Star Office 
Apps-02 

Spreadsheet (Star Calc)
Publishing(Star Draw) 

Presentation 

Calendar 

Desktop Explorer
(documents, files & folders)

ADDRESS Book 

tip: 
"Click" here to insert a 

graphic into the page 
that you are working on!! 

tip: 
"Click" on View then Zoom to 
change the working page size!! 

tip 
"Click" here to change the margins, 
print formatting, PAGE formatting 

select grid lines, etc. 

star office 
DOCUMENTs 

WordProcessing 

(Star Text)
Open/Close 

Explorer 
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A B E 
Roger works evenings and weekends repainng computers, building 
websites, and landscaping for clients. He found that his notebook 'Hme yi 
finance" system was no longer adequate as he was making a lot ofo/ey. 
He needed a system to track his income. The following spreadsh~t was 
designed to accomplish this task. 

----1----"'C=at=e_g=o,_,ry,_----J.-,Tlme 

9110101 Joe's Antigue Shop Web pages 4.50 $125.00 
9/11101 

9113101 Mrs. Jones 
9114101 Robert Rhuman 

, - - - - - - - - - - - - - - - - - -- - - - - - - - --

...................... 
................... ... 

$562.50 Began MySQL~ata I 
$0 00 
$0 00 

$70.00 
$264-.00 Re laced the 

$1 , 166.50 

Maslow's Hierarchy of needs 
Abraham Maslow :is k.ooe"Wn for establishing the theory of a bforarcby of oeeds, 

writing that bu.man be ings are motivate d by uosati.sfied needs , aod that certain lov.rer 
powcr:s need to b e satisfiedbe.fo r higher needs c an be satisfied. Maslow studied 
ex.e.mplary people such as Albert E:i.nste.io, Ja.oe Addams, Eleanor Roosevelt, aod 
Fredrick: Douglas rather than .rneo.tally ill or neurotic people. This was a radical departure 
from two of the ch:ie.f schools ofpsycbology of bis day:Fre ud and B.f. Sk::ir::w.e.r-. 

At once other (and higher) needs anerge, and these, rather tha.n phsiological 
hungers, dominate the organism. And when these in turn are satisfilll., again n~ 
(and still higher) ne.t!!d.s e.1ne.rge., and so on. A s one. de.sire. is satisfied, another 
pops upto take its place. 

Th. e H ierarch v o r.Needs 
SELF _ACTUELIZA TION 

SEH'- nd.filhnent or findin.g you:i.· 

<sling 

ESTEEM NEEDS 

R ecognition a nd :respect 

PSYCBOLOGICAL NEEDS .J 
BeJ.on ging, )o\o'E-, and ac,ceptantlll 

SAFETY NEEDS r 
Se.curi ty and stabili ty 

PHYSIO L OGI CAL N EEDS 

Air , water , and fo:>d 

J. 'f"-=lo: ,i,it,m.,, DIILW tt,:ay :ui.:I 
ll&nfi Clfw ~..:,: II'.: •• 

1943 
'JbcINIAC" 

......_.._,�� I � 1 1 I.I II 

:.:.s.5Grj! !n, ·-~ 
---T..........,;. ___ _ 

.....--

..,,__ 

in
Star OfficeSpreadsheet Adjust column width 

Grid lines 

Insert 
graphics 

Text box (grey background) 

Creating 
Things 

Apps-03 

Text 

Orientation    = Format->Page->Page 
Grid Lines   = Format->Page->Sheet 
Summing #'s = "select numbers to add" 
- ->"hit the enter key." 

Tables-
Insert->Table 

Text Box Presentation &Draw (Publish) 

Insert graphic 
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0 

0 

"1" 

Ill 

(0 

r:.. 

ciJ 

qi 

~ 
0 
,:-

Macro ... 
.C.onfigure ... 
Qptions, .. 

... , ... ·1 .... , ... -2·· .. , .. ··3·· .. , .. ·4-· .. , ··7 ·· •···8·· 1···9·· ··•···10···'···11···•· ·12··· 1 

! I I • . . . . . . . . - . . . 
... .. , .. . ·· -· ... . . .. . .. , ..... , .. ····· ·· ·•···· ·· ·· ·····" " "' ··· ·· ·· .. · ·· · ·· · · • 

-----

Options - General - Save Ii It:! 
EI--Ge neral I 
· a Data 

1

-

Paths 
Language 
Colors 
Print 
Font rep lace me nt 
View 
Desktop 
Other 

!±I-I nternet 
1±1- Browser 
1±1- Text document 
1±1 HTML Document 
$- Spreadsheet 
1±1- Prese ntation 
[I- Drawing 
$- Picture ... 

Save= .-------------------= 
Idit document properties before savfog 

""l AIY{ays create backup copy 

M E. rom pt to save 

Save graph ics===-=:i 

_, Original format 

Undo ----:---:------=~ = ~ = -------------=i1 
Number 2f steps §_§ ___ Jffi 

I OK l Cancel Help 

[ .... : .... : .... :, ... ; .... ; .... ; ... . : .... : ... . : .. ,. ; ... ,:' : ' ..... .... , .... .. .. ,. 

: : ... ~ . I 

~ack 

in Star Office 
Configuring Apps-03 

Things 

Tools => Options => Save -> Autosave every  (15-20 minutes) 
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l ,~ --l);l KDE Mall arent Kt.tall 

: Fil~dit View Folder Me ss arie c ~++inno 1-l ~ ' ri 

~ h b h ~ ~ FA ~ n ni•· il'Yh ac- ~ j.j ac­lJ ,rt:::,~ ~~ ~ ~ ~~ ~ ~ 
~F ~-:::.l-'-=:---___:._---,,.,--------------==-----------.-----------,------------.rll' 
i Folcfflrs \ Subject (Status) \ I Sender I Date (Order of Arrival) I ' . 
( ~ ' . -

j .......,.. I 

: · E/sent- hail 

! @ trash 

! \TI draft 

! D cont xi 

'- DEBc 
I·· Oltsp erv er Proje ct 

, !· \TIPC Apps 
' !· O StF JT 

'---~Va oo-robertc (62) 

j -

1----------------------------,._------------------------------' 

= 

@'s~ (urmruned) - KMail 

Message _Edit Yiew Qptions .8.ttach ~ettings .tie lp 

!""' ll"ffl'[y: I Default ..,......... 
l \ 

... Jr Sticky ';:===============::\====== I ·· · I Io 

£.(: l \ I -- 1 
s1 bject: .I \ 

~ I \ 
I y 

I= 

- I I Co lumn: 1 I Line: 1 ~ 

w 

in
KDE Mail 

Sending 
Things 

Apps-05 

Attachments 
Send Mail 

Mail Box 

Compose message 



 

 

. . . . . 

. . . . . . . . . . 
··: · · ·: · · ··: ·· · ·: · · ··: ·· · · · · · ··: ·· •·: · · ··: ·thE£ E£ .a"tex1: box ····:· -- · :· ·· 

-=~~-"""'~---t·r-: _.,_ 'r-: - -L 
1
. --: --. -~ ----: -v/2th: ~lin~ ~~ it : ----: ---

· -:- · ·: · · ; : : : · · -:- · ·: -~--/ -· l · · · · l · · · · l- · · -:- · · :- · --:- -· ·i · .. · 
··:· . : ···· : ····: ·· ·· :·· : ···:·· ·:· / ·· --;··· ·;··· ·:-···:--· •: ····:· -··:··· 

. . --~ . . . . . . . . . . . . . . . . . . . . . . 
-=><·::--· · Uris :is ~e type :of cpmputer · : · · · · 

; · w¢us:e·at:Caieer Jech:··:· - ·I··· 
. . . -- ---- ·o ··----- . . . . . . . . . . . . . . . . . . . . . . . . . . 

:::· .:/::: j::::::: ·· 1:::: :::):: .: :::. _ : ::::::::)::: T:):::T:: 
• • • • • • • • • I • • • • • • • • • • • • • • • • • • • • • • • 

' • I • . . . . 

-
. . 

(.jJ 
. . .... , .......... , .... . .. ..... .. . . . . . . . . . . 

- . ........ . ................... . , 
• • � • . . . . . . 

r:--
. . . . 

- . ... . ....... · ······ · .. .......... . . . . . . . . . 
. . . . . 

Q) 
. . . . ... t ••··· ·· . .... ....... ... ........ . . . . ••• •••••••• ~ ••••••• t ••••••• •• ••• • • . . . . ' . ' . ' . . . . . . . . . . . 

- .... .... .... · · ······ · ··· ··· ........ , ............ ........ ..... .. ... , . ...... ··· · ···· 
o t I I o I . . . . . . 
. . . . . 

Q1 . ... . . ...... . ...... . ::::::==:::::=:::::::::===::::::::::=::::=:::::::: · .... , ....... ... .. . . Tti<[: ,:: ;:1 1 :J 
. . . . . . . . . . . . . . . 

Apps-04 

Creating 
Things in 

Star Draw 
Star Draw 

Rotate 

Text Box 

Box 

Insert Graphic 

Shape 

Insert ->Spreadsheet 
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Recycle Bin 

Internet 
Explorer 

~ ,_J.ifiia 

Network 
Neighborhood 

Sb 1 • I 

Apps-06 

Accessing Your folder 
from the I-Net Win 9x computer! 

tip: 
Be SURE to 

LOGIN 
exactly the same as you do 

for Linux. 

Your 
folder name here! 

Double "Click" 
on each "icon" to select 
and follow the arrows! MS Windows 
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Case & Power Supplies 

Tux 

Tip #1 
Generic computer cases 

are generally fastened using 
screws on the back of the top 

cover. 

tip# 
2 

ATX power supplies generally 
have a single power plug 

for the 

tip# 
3 

AT power supplies generally 
have a 2 piece power plug 

for the 
m 
o 
t 

tip# 
4 

AT cases generally have a 
single hole for a large 
keyboard connector.. 

Tip #5 
ATX cases have a cutout (holes) 
for a PS/2 mouse & keyboard and 

peripheral ports. 

tip #8 
Extra fan locations for 

extra CPU cooling.. 

Hdwr-01 

tip#6 
Proprietary cases have non-

standard motherboard slots, power 
supplies and cover fasteners. 

Watts CPU Su  orted Certifications 

100-200  eleron, Duron & Pentium Generally not req. 
200-300 Most  PUs & PII, P4 P4, AMD required 
250-300 Athalon, P4, AMD Xp Required 
300-400 Servers & Dual processors 

Tip#7 
Power Supplies are rated 

in watts. The wattage of the 
power supply must match the 

requirements of the motherboard 
& CPU used. 
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Hdwr-02 

MotherboardsMotherboards 
The Motherboard 

CPU 
(socket) 

AGP Bus 

RAM -memory 

PCI Bus 

CPU Slot 

Chipset 

This ATX style 
motherboard is the heart of the 
PC. All components connect 

through it. 

Tip#03 
Primary & secondary IDE 

ports for access to IDE storage 
devices (40 pins). 

Tux 

tip # 
Parallel port,. 

connects to printer, 
scanners, etc 

(25 pin) 
connector. 

Tip# 
Game port for 
joysticks, etc. 

(15 pin)Tip# 
Sound- speakers, 

earphones, microphones. 

ISA Bus 

Tip# 
Video controller 
port. (15 pins) 

tip# 
Serial (9 pin) 

connector. 

tip# 
USB connectors 

(Universal Serial Bus) 

Tip#04 
Chipset controls the access 

between the CPU and 
motherbd components 

Mouse & 
keyboard ports 

ClockTransfe 
8Mhz 8Mbps 

tip#01 
The CPU must match 

the socket or slot on the 
motherboard. 

tip#02 
RAM must match the 

appropriate socket on the 
motherboard. 

Floppy 
connector 
(34 pins) 

Clock Transfer 
100Mhz 1000MBpsPeripheral Connect Intfc. 

Integrated System Architecture 

Accelerated Graphics Port 

BIOS / CMOS 

Basic 
Input / Output System 

&configuration file- holds 
configuration 

information for the PC. Clock Transfer 
66Mhz 132Mbps 

RAM Pins Description 
Type 

SIMM 30 / 72 

DIMM 168 PC66, PC100, PC133 
DDR 184 pc133/2100 

RDRAM 184 

Socket / Intel AMD Cyrix 
Slot 

Socket 3 486 
Socket 5 586 
Socket 7 Pentium K6 MK2 
Socket 8 Pentium Pro 
PPGA 370 Celeron CPGA 
Slot 1 Pentium II 
Slot 2 Xeon 
Slot A K7/ Athlon/ Duron 
Socket A /452 K7/ Athlon/ Duron 
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Approx. number of Approx. number of 
Dot Pitch pixelstcm2 pixels/ii( 

.25 mm 1,600 10,000 

.26 mm 1,444 9,025 

.27 mm 1,369 8,556 

.28 mm 1,225 7,656 

.31 mm 1,024 6,400 

.51 mm 361 2,256 

1 mm 100 625 

0 
0 

0 

Hdwr-03 

VideoVideo 

When a graphics card handles 
color, it does it in one of two 
ways. A true-color card devotes 3 
or 4 bytes per pixel (4 bytes allows 
an extra byte for an "alpha 
channel"). On a 1600x1200-pixel 
display, this adds up to about 8-
million bytes of video memory. 

Tip# 
The display monitor may 

connect either to the 
motherboard or to a separate 

video card. 
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Tip#2: 
IDE cables have 40 pin edge 
connectors with a 40 wire flat 

cable for ATA33 
(33Mhz) speeds and below. 

IDE Storage DevicesIDE Storage Devices 

Tip#3: 
IDE cables have 40 pin edge 
connectors with a 80 wire flat 

cable for ATA66 
(66Mhz)speeds and above. 

Tip#1: 
-The total number of IDE 

devices per c ble &
controller is 2. 

tip#4: 
The red stripe is 
cable PIN #1 & 

generally goes toward 
the drive power 

connector 

tip#6: 
Drive configuration 

instructions are 
generally found 

here. 

tip#5: 
The power connector. 
connects to the 4 pin 
power connector on 

the power supply. 

Single 
Master 
Slave 

tip#7: 
The IDE cable connects to 
the Primary or Secondary 

MOTHERBOARD 
IDE Connector 

. 

tip#8 
The m nuf cturer & 
model #'s provide

critic l info  s to device 
size  nd softw re 

drivers required to run
the device. 

Single = 1 drive 
1 Master & 
1 Slave  = 2 drives. 
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Hdwr-05CPUCPU 
(Central Processing Unit)(Central Processing Unit) 

"386" 

Pentium 

Not in production 

tip #1 
cpu(s) from type "8088" to the 

ppga celeron are no longer in 
production. Though still in use they are 

being replaced as the price of faster 
CPU(s) decrease. 

ppga-Celeron 

bottomTop 

fc-pga CeleronSocket 370 

tip #2 
CPU(s)  must be matched 

up with an appropriate mother 
-board & CPU socket. 

Current production 

Duron / Athlon 

Socket 462 

tip #3 
A CPU's speed can generally 

be found as the last 3 #'s 
of the CPU model #. 
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CPU & RAM Chart 

SIMM 
RAM - Random Access Memory 

Ty e Name S eeds Ca acity 

SIMM 30 Pin 
SIMM 72 Pin 80 ns / 70ns / 60ns 4 Meg - 64Meg 
DIMM 168 Pin 66Mhz / 100Mhz / 133Mhz 16 Meg - 1 Gig 
DDR 180 Pin 

RDRAM 180 Pin 

CPU Char 

DDR 

DIMM 

RDRam 

Mother d 

Microprocess 
or 

CPU Socket 

CPU 

Manufacture 
r 

CPU 
Speeds 

(in 
Mhz) 

CPU Class Typical RAM Mother d 

 us Speed 

Socket 3 Intel/AMD/Cyr 
ix 

33-100 
486 

30 pin/72 pin 33-66 

Socket 5 Intel 60-90 586 30 pin/72 pin 
Socket 7 Intel/AMD/Cyr 

ix 
100-233 Pentium/MMX 72 pin/168 pin 66 - 100 Mhz 

Socket 370 
(ppga) 

Intel/Cyrix 266-700 Celeron 168 pin 
PC66/100 

66-133 Mhz 

Socket 370 fc-
pga 

Intel 266-950 Celeron/PIII 168 
pin/PC100/133 

100 -133 
Mhz 

Socket 462 (A ) AMD 400- Athlon/Duron 168 pin PC100 100 -266 

bottom Top 

fc-pga Celeron Socket 370 

Pentium II/III 

ppg C l ron 

Socket 370 

Pentium 4 

Duron / Athlon 

Socket 462 

Tip# 
CPU's, RAM & motherbds 

must be compatible with each 
other 



 

   

 

 

Tech Tips 

~ 
Lincoln Cit 

• Raun'dilp 

. intel@ ~©·,;, 
t_J 

-~ -~- ,_ ~ .... 

Tux 

Hdwr-07a 

PC Identification Chart 

Component Description 

AGP Bus ==========================> 

Case -top ==================> 

Case -bottom ==================> 

Chipset No standard form or format. ==> 

CMOS / BIOS ==================> 

CPU Central Processing Unit ====> 

Floppy Diskette High density = 1.44 MegaBytes ========> 

FloppyDrive 3.5 Floppy Diskette Drive  (capacity) 1.44 MB ==> 
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PC Identification Chart 

Component Description 
Floppy Drive Cable 34 pin flat cable (twisted end to drive #1 -----> 

IDE Hard drive 40 pin edge connector -----------------------> 

IDE Cable 40 pin flat cable ------------------------------------> 

ISA Bus Generally black (2 Sections) ===========> 

Mouse port (ps/2) Round 6 pins & alignment pin (green)====> 

Keybd port (ps/2) Round, 6 pins & alignment pin (purple)-----> 

Parallel Port Edge connector w/ 25 pins -female =======> 

PCI Bus Generally white, 2 sections ========> 

Power Supply ATX (1 connector), AT (2 connectors) ===> 

Serial Port Edge connector w / 9 pins -male ========> 

PCI 

Video controller Edge connector w/ 15 pins -female =======> 
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PC Component 
Identification Chart 

Component Description 
RAM  (SIMM) 72 pin ========================> 

RAM (DIMM (sdram) 168 pin   =====================> 

RAM  (DDR) 184 pin  ======================> 

RAM  (RDRAM) 184 pin  =======================> 

Network Card (NIC) RJ45 connector - 8 pin / wires --------> 

Modem Card RJ11 phone jack - 4 pins /wires --------> 

Link 

Phone 
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Bench Testing 
COMPONENTS

Hdwr-08 

 Motherboard Testing

+ & + ++ or 

 Floppy Drives

+ + 
Boot Diskette 

Working computer 

 Hard Drives
IDE Cable + + &CD-ROM Drives 

Free IDE port 

Working computer 

Replace working 
 Memory + = Memory 

with 
Memory to Test 

Working computer 
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0 
0 

0 

✓ 

0 
0 

0 

0 
0 

0 

PC Disassembly 

Tip 
Locate and remove the 

fasteners- they may be screwe, 
tabs, buttons or ??? 

Remove 
the 40 pin (wire) IDE 

cable - (from the motherboard 
to the hard drive or CD-ROM 

drive 

Remove 
the flat 34 pin (wire) 

floppy drive cable - (from the 
motherboard to the floppy 

diskette drive. 

Removal 
Screws from top / side cover 
Remove top or side cover 
Remove hard drive cable 
Remove floppy drive cable 
Remove RAM or Power Supply 
Remove RAM or Power Supply 
Remove  PU fan 
Remove  PU 
Remove hard drive 
Remove Floppy drive 
Remove motherboard 

Lift CPU out 

Tip# 
Lift handle on side of CPU 
socket & lift CPU out of the 

socket!! 
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Tech_labs OpSys-01 

Introduction to 

Operating Systems 
MS-DOS (Disk Operating System) 

DOS is very compact (very small and fits on a single floppy with appropriate utilities.  It was designed 
originally for computers with floppy drives only. 

DOS with appropriate utility programs can be a very usefull tool for configuring and testing a computer 
system. 

DOS on a diskette may be required to load the Windows operating system. 
Everyone should have their own copy of a DOS boot diskette if they own a computer. 
There are non microsoft DOS versions available. 

features. 

MS-Windows 
Windows comes in various versions and updates beginning with Windows (v1.0, v2.0, v3.0, v3.1, v3.11), 

Windows 95(a/b/c), 98(std & se), NT3.5, NT3.51, NT4.0, Windows ME, Windows 2000 (prof & enterprise), 
& Windows XP. 

Windows 3, 95, 98, ME are generally for personal and home use with little to no security or safety 

Windows NT, 2000 & XP have built in security which allows multiple users to use their own secure corner 
of the operating system.  These also have the ability to function as a secure server - the ability to  share data 
files and printers. 

Linux & Unix 
Linux and Unix or secure operating systems with controlled access - (login & password security).  These 

operating systems provide the ability to share printers and files.  Linux is public domain software which is 
available at no purchase cost to the user.  Technical support is available both on donated time and for fee 
basis. 

Linux and Unix are very stable and cost effective solutions for schools. 
These operating systems are the primary systems used for the Internet. 

DOS 
Not graphical 
not secure 
single task 
 osts 

not in production 

Windows 9x / me 
Graphical GUI 

some login security 
File & print share 
Replaceable drivers 

Multiple tasks 
ME is current version 

Windows NT Linux 
Graphical GUI Graphical GUI 
Login security Login security 

File & print share File & print share 
Replaceable drivers Kernel drivers 

Multiple tasks Multiple tasks 
Workstation version Workstation version 
Server version Server version 

Domain manager Domain manager 
Terminal server version Terminal server version 

not in production  ost = Public Domain $0 
 ost = $550-100k Multiple distributions 

Unix 
Graphical GUI 
Login security 

File & print share 
Replaceable drivers 

Multiple tasks 
Workstation version 
Server version 

 ost = $1000-$1m 
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Operating System 
Requirements 

General (Typical) Operating System Requirements 
O erating System RAM FDD-HDD File Systems Partitions CPU / S eed 
DOS 1 Meg 1 Meg - 500 meg FAT 1 ( :) 286 / (any) 

Windows 95 16 Meg - 128 Meg 100 Meg - 8+ Gig FAT32 1 or 2 ( :, D:) 486+ /50 Mhz+ 

Windows 98 32 Meg - 256 Meg 200 Meg - 40+ Gig FAT32 1 or 2 ( :, D:) Pentium+ / 200 Mhz+ 

Windows ME 64 Meg - 256 Meg 1 Gig - 100 Gig FAT32 1 or 2 ( :, D:) Pentium+ / 300 Mhz + 

Windows NT4.0 64 Meg - 512 Meg 1 Gig - 20 Gig FAT or NTFS 1+ as required Pentium+ / 200 Mhz + 
(Requires svc packs) 

Windows 2000 128 Meg - 512 Meg 2 Gig - 100 Gig ??? 1+ as required Pentium+ / 700 Mhz + 

Linux Mandrake 32 Meg - 1 Gig+ 1.5 Gig - 100 Gig Ext2, Swap 3 Pentium+ / 200 Mhz + 
(Root,Swap, Home) 

Linux LTSP 128 Meg - 1 Gig+ 2 Gig - 100 Gig Ext2, Swap 3 200 Mhz + 
(Root,Swap, Home) 
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Title: Introduction to PC Software 

The User communicates thru the Operating system(s) which 
communicates with the PC hardware through the Basic Input 
Output System. The BIOS in turn connects and communicates 
with various peripherals like hard drives, floppy drives, printers, 
monitors, keyboard & mouse and programs, data, and file 
systems. 

Operating System 
Windows, Linux, Unix 

BIOS 

CPU PCI 

IDE Controller 

Operating System 
& the 

BIOS / CMOS 

Hello 
world! 

Keyboard 

Hard drive 

Operating System User BIOS 
Windows, Linux, Unix 
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HDD Partition 

Partitions 

Partitioning -Disk storage drive platter surfaces must be prepared for program or data file storage using a 
program called FDISK or Diskdrake.  Partitioning creates the "table of contents" for the hard (storage) drive 
so that as files are added to the surface of the drive they can be found later. 

Formatting: used to finish the preparation of the drive surface for file storage. 

Different operating systems require different types of partitions. 

Partition 
information 
Written here FDD, HDD, 

CD-R, Mbd, 
Windows 
95/98 

monitor, ps start-up 

Format 
diskette 

information 
Written here Keyboard 

Mouse 

MBR - Master Boot Record 
(outside edge of the platter) 
- The boot (the startup) 
portion of the storage media. 
 This contains the 
instructions about which 
partition and operating 
system to use at start up. 



 

   

 

   
   
  
  
     
  
 
    
  

  

  
 

 
 

 

  
 

   

 
 

    
        

     
     

   

   
  

     
 

  
 

  

Tech_labs OpSys-05 
Operating Systems 

•Loading the MS-DOS PARTS LIST: 
1) A working computer with a hdd, fdd, RAM, •Operating System Mbd, Kbd. CD-ROM drive & CPU, PS.& NIC. 
2) A copy of Windows 9x boot floppy diskette. 

Partitions -Disk storage drive platter 
surfaces must be prepared for program or 

Windows data file storage. Programs such as 95/98 
FDD, HDD, fdisk or Diskdrake and start-up 
CD-R, Mbd, diskette format are used to prepare the surfaces. monitor, ps 

Different operating systems require different 
types of partitions. 

Keyboard 

Mouse 

MBR  - Master Boot Record (outside 
edge of the platter) - The boot (the 
startup) portion of the storage media. 
This contains the instructions about 
which partition and operating system to 
use. 

• Loading MS-DOS 
• 1> Obtain a copy of the Windows 95/98 start up diskette 

• & insert into the floppy drive. 
• 2> Boot your computer by powering on 

• or using the "ctl+alt+del keys. 
• 3> Select option #1 "With CD-ROM support." at the display prompt. 
• 4> Type fdisk at the "A:>" prompt & press the enter key. 
• 5> Select #4 from the menu to view the partition table. 
• 6> Select "esc" to return to the menu. 
• 7> Select #3 from the menu to remove the current partitions -follow onscreen instructions. 
• 8> Select "esc" to return to the menu. 
• 9> Select #1 from the menu and install a new "primary" DOS partition. 
• 10> Type format c: /s at the "A:>" prompt -press the enter key & follow the instructions. 
• 11> Type sys c: at the "A:>" prompt - press the enter key & follow the instructions. 
• 12> Remove the floppy disk & Reboot (ctl+alt+del) the computer. 
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Loading Windows 9x 
Things I Cklst Task 

Need!! 
*** Install DOS on your hard drive **** 

- Use fdisk to p rtition the drive. 
- Use format (form t c: /s) to form t the p rtition. 

1) Boot from DOS diskette "with  D-ROM support" 

***  Inser  Windows 95 CD in CD-ROM drive 

3) At the "A:>" prompt type C: & En er 
4) Type MD \windows at the  :> prompt Working, tested PC!! 
5) Type MD \windows\op ions at the  :> prompt 
6) Type MD \windows\op ions\cabs  at the  :> prompt   & " hit the En er ke 

Windows9x 
*** Loca e  he Win95 direc ory on  he CD-ROM Install Diskette + 

7) Type D: & Enter then type dir /w (look for a Win95 directory) 
8) Type E: & Enter then type dir /w (look for a Win95 directory) 

*** When the "win95" directory is found  type   dir to view the contents. 

- Type CD win95 at the prompt and hit the enter key. + Windows9x 
9)  opy the windows setup files to the  : drive Install CD 

- type Copy *.* C:\windows\options\cabs "hit the enter key" 

10) Make sure the floppy diskette is out & reboot the P . 

11) - Type  D \windows\op ions\cabs at the prompt  and "hit the en er key". 
- Type se up &  "hit the en er key" +

12) Follow (answer) the onscreen prompts until windows is installed. 

13) After Windows is installed: 
- Select "Start" "settings" " ontrolPanel" "System" 
-  heck for any  ? (question marks)  - the question marks must be cleared Installation key 
- ? marks can be cleared by installing proper drivers which can be found by 

downloading software drivers from the internet.  Drivers will be found 
by searching based on the Mfg., Model# and serial #  (if any). 

- Install the drivers into the Windows installations by:
 1) Executing the driver setup program or
 2) Removing the device from the system control panel, restarting the P , 

and letting the driver install program search the floppy or  D for the file(s). 

14) Type, grammer check & spell check an instruction guide for installing 
windows 9x. 
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Things I 
Loading Windows4.0 Need!! 

Cklst Task 

1) * Inser   "Windows NT Works a ion" CD in CD-ROM 

2) Boot the P  with the power switch or the " tl+Alt+Del keys. 

3} Follow the onscreen prompts. 
Working, tested PC!! 

4) Assistance will be provided as needed. 

Type, grammer check & spell check an instruction guide for installing
    windows 9x. + Install CD 

+ Service 
Pack CD 

+ 
Installation key 
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Install CD's 

Tech_labs OpSys-08 

Intro to PC Software 
Name.......: _______________ 
Date.........: ___/___/___ 
Instructor: _______________ Loading Linux 

Things I Task 
Need!! 

1 Obtain a working tested PC with CD-ROM and a hard drive(s) with at least a total of 
at least 1.6 gig or more, a digital tested monitor and 3 Linux Mandrake 8.x 
installation CD's. 

2 Create a component list by examining the components or  by examining the
 CMOS configuration. 

3 Modify the CMOS of the PC to boot from the CD-ROM. 
Working, 

4 Insert Linux CD #1, the install CD in the CD drive. tested 
PC!! 

5 Reboot the PC. 

At the on-screen prompts: hdd = 1.6gig+ 
6 Left mouse click on "OK" for language = United States. monitor = digital 
7 Left mouse click on "Accept" for the license agreement. RAM = 64 meg 
8 Left mouse click on "Expert" and "Install". 
9 Left mouse click on "No" and "OK" for any SCSI interfaces. 
10 Left mouse click on "OK" for mouse = "Standard". 
11 Left mouse click on "OK" for "US Keyboard". 

Linux 12 Left mouse click on "OK" for security level = "Standard". 
Mandrake 

8.xAt the partition setup screen select the following: 
13 Left mouse click on: 

A- "Clear All" to delete all existing partitions. 
B- Create the following partitions by left mouse click on the white space then on the 

color of the partition required. Create partitions of the following sizes. 
1- Green = swap partition = 2 times the size of memory. 
2- Deep red = journalized partition = / (root) = 1.3+ Gig. 
3- Deep red = journalized partition = /home = 250+ Meg. 

C- Left mouse click on "Done" when finished. 
D- Left mouse click on "OK" for "Partition table written to disk". 
E- Left mouse click on "OK" to 'Format partitions". 

14 Check on "all install CD's" and left mouse click on "OK" 
-  (Note - Make sure the install package total is less than 1.2 Gig.) 

15 At the root password prompt - type "Admin0101" and "OK". 

16 At the user add prompt - add yourself as a user and choose your password. 

17 Accept the default monitor/video interface selection and test. 

18 Follow the rest of the on-screen prompts. 

19 Type, grammar check and spell check an instruction guide for
  installing Linux Mandrake 8.x. 
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TX+·1 ========== 
TX- .2 ::::==================~ 
RX:+- 3 o:=====:==:==~;;;;;::======i 4---------­s ========== 
RX- 6 ::::===================:: 

7 o:=====:==:==~ ;;;;;::======i a----------
Thi s further IPC 

HU B 
1 RX+ 

2 RX-

3 TX.+-

4 

5 

6 TX.-

emphasizes, I hope, 
the importance of the 
word "twist" in making 
network cables which 

B --. .... 
7 

R - G c:==~ 
s 
4 

will work. You cannot RX:+ :;:;i 

us e an flat-untwisted n :. z i:==::;.--:::.,, 
telephone cable for a n:+ 1 ----=-

O range 
Paii- 2 

R J -45 J A 
E IAJTIA 568A STA' 

If we apply the 568A color 
like this: 

PC 
TX+·1 

TX- 2 

RX+ 3 

4 

5 

RX.- 6 

7 

8 

CROSSOVER PC 
,,-:::=~ 1 TX+ 

c:::=====:y;~ ,;:==::::, 2 TX­

;:::_== 3 RX+ ------1.. , ___ 4 

c:::====~ A \:=== s 
-.....:::= =eRX­

c:====-======= == 7 ----------a 

G reen 
Pair- 3 

HUB 
/~~ 1 R)I+ 

~;;::::::=l 2 R X~ 
3 T'X+ 
4 
5 

6 Tl<­
-.=:=:, 7 

...._ __ 8 

Orange@ue Brown 
Pai r 2 Pair 1 Pair 4 , - - .......... 

: 12345678 12345678 12345678 12345678 

STRAIGHT-THRU 
5668 

Tech_labs Netwk-01 

Intro to Network Cales 

Use crimping 
tool to crimp 

wires to 
connector 

Crossover - connects 
2 hubs together. Straight-thru connect 

computers and hubs together. 


